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Guide to using ConnectMyFiles Part I:  Introduction
What is ConnectMyFiles?
ConnectMyFiles is an file-storage application designed to put selected files on a Global Network of 
Servers.  This is an alternative to storing data on floppy disks, cds, dvds, flash drives, or even standard 
hard drives.  It keeps all of your data secure and in addition, allows you to access the files using a Web 
Interface that can be accessed anywhere there is an Internet Connection.  

ConnectMyFiles not only acts as a storage center, it also acts as an security device.  Because the 
program can be set to automatically scan for alterations in your files, it will back them up whenever 
they change.  This way, you don't have to worry whether or not the latest version of a file is up to date. 

Using ConnectMyFiles:  The Interface
ConnectMyFiles has two parts.  The first part is the local interface.  This is a software application that 
you download and install on your computer.  From there it can scan all of the local drives (depending 
on what you've selected) for files to backup.  

The second part is the ConnectMyFiles website.  Unlike the local interface, you don't have to download 
or install this part; it's online.  And that means that you can access it from any computer that has an 
Internet connection.  This interface is where you can view the files you have backed up, download 
them, or delete them.  Essentially this means that the files you've stored on ConnectMyFiles have 
become universally accessible.  Go anywhere in the world where there is an Internet connection, and 
you can see and control your files.  
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Guide to using ConnectMyFiles Part II:  Scanning, Backing 
Up, and Managing your Files
Step 1:  Choosing the files to be backed up
When you first load the program you will see the scanning dialog; it says “Scan and Backup.”   Notice 
that the there are three tabs at the top of the window; one says Start, one says Status, and one says 
Restore.  You should currently be on the “Start” tab.  These tabs take you through the three stages of 
having a truly accessible Backup, step by step.  

On the “Start” tab, you will see eight separate checkboxes and a ninth option that says “Add Backup 
Locations.”  Each of these boxes corresponds to files that people most often back up.  By clicking on 
any given checkbox, you tell ConnectMyFiles to backup every file that checkbox corresponds to:

1. My Documents – will backup all files in the “My Documents” folder
2. Desktop – will backup all files on the Desktop
3. Pictures – will scan the computer and back up every picture file it finds.
4. MS Office – will scan the computer and back up every Office Document it finds, including

➢ Word processor files and other text-based documents.
➢ Spreadsheet files like those associated with Microsoft Excel or Lotus 1-2-3. 
➢ Presentation files like those associated with Microsoft PowerPoint.
➢ Database files like those associated with Microsoft Access.

5. Favorites – will scan the computer for links stored in your “Favorites” in Internet Explorer.
6. Music – will scan the computer and backup every music file it finds.
7. Email – will scan the computer and backup every saved email it finds.
8. Productivity – Will scan the computer for any files related to business and money management. 

Files like this include PDFs and those associated with Intuit Quicken and Microsoft Money.
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The checkbox that says “Add Backup Locations”  allows you to be more specific when 
choosing which folders you wish ConnectMyFiles to look in.  Perhaps you wish to scan 
for all music files on your computer except ones in a certain folder.  By accessing the 
“Add Backup Locations” dialog, you can tell ConnectMyFiles which folders to scan and 
which to leave alone.  Perhaps you have some files that don't fit into one of the other 
eight categories that you would like to back up.  The “Add Backup Locations” dialog 
allows you to seek out specific folders and tell ConnectMyFiles to take everything in 
them, no matter what kind of file they are.  

Quick Question:  Why does it say, “Disable Backup of Video Files (Recommended)”;
Can't I backup video?

Yes you can.  The first time you choose to backup the files on your computer, it will take a relatively long 
time.  Since videos are often the largest types of files, we recommend backing them up separately at 
different times.  By un-checking this box, ConnectMyFiles will scan for any video files and include them 
in the Backup.  

Step 2:  Scanning
Once you've selected which folders and file types you wish to scan for, simply click the “Scan” button. 
ConnectMyFiles will scan the computer and give you a report of the files it has found.  This process 
can take a couple of minutes.    

When the scan is finished, the window now displays which files it has found to backup, and the caption 
on the screen now says “Results.”  Notice that you are now on the “Status” tab and the “Scan” button 
has been replaced with a “Backup” button.  On the left of the screen you will see the total number of 
files to be backed up.  On the right, you will see a list of the files that are ready to be backed up.  If 
there is a small, black triangle beside the entry, you know that this is a folder.  Clicking on the triangle 
will open the folder, allowing you to see what and how many files are inside. If you find that you can 
navigate through the folders but it's still simply too crowded, notice the small tabs called “Normal View” 
and “Detailed View.”  By clicking on the “Detailed View” tab, you can expand the screen so that you 
can see more of the files' information.  
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Adding additional backup locations
Even though the scan is complete, you can still adjust what goes into backup and what doesn't.  When 
viewing the files, you have the option to un-check any given file that you don't want to be backed up. 
Alternatively, by clicking the “Add Backup Locations” button in the bottom left-hand corner, you can 
again specify any particular files that perhaps weren't included in the initial scan.  

        

           

Quick Question:  What if I just want to drop everything and rescan?

That's no problem.  Anytime before you click “Backup” you can cancel by pressing the “Cancel” button 
on the left side of the screen.  This will take you back to the “Scan and Backup” screen where you can 
opt to re-scan your PC.
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Step 3:  Backing up your files
To back up the files you've selected, simply click the “Backup” button and ConnectMyFiles will begin 
sending your files to our Secure Global Network.  The amount of time it takes to store all of the 
information is proportional to how much information you're backing up.  Regardless, any time you 
transfer a large amount of data it will probably take a while.  This long transfer time is a tenant of the 
first backup.  Since subsequent backups don't usually move the same, large amount of information, 
they will be much quicker.  

There are four counters that monitor the Backup process:

1. Total files – this is the total number of files that were selected for backup.
2. Total files sent – this counter counts down, indicating that number of files that have been moved 

from the waiting list to our Global Network.
3. Total files checked – this counter counts up, indicating the number of files that have been put 

into the Backup and verified.  
4. Total files in backup – this is just what it says, the total number of files you have in our Global 

Network.  

There are additionally two progress bars.  The top one lets you see how much of the current file being 
transferred has been backed up.  The bottom one lets you see how much of the total project is done.
Beneath the progress bars is a ticker that lets you see exactly what file is currently being transferred.

Stopping a Backup in Process
To stop the Backup process at any time, simply click the “Stop Backup” button, and ConnectMyFiles 
will stop the transfer of files.  
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Quick Question:  What happens to the files when the Backup gets canceled or interrupted?  

Sometimes you will wish to stop a backup already in progress, and sometimes uncontrollable things 
happen that disrupt the Backup project, like a power outage or a loss of Internet connectivity.  Whatever 
happens, ConnectMyFiles keeps track of which files have been backed up and which ones haven't.  If 
you decide that you wish to restart a backup project after it's been stopped, simply re-click the “Backup 
my Files” button and ConnectMyFiles will start right where it left off.  If the connection with the Global 
Network was interrupted in the middle of a file's transfer, then ConnectMyFiles will start transferring that 
file over.  This way, there are no incomplete or corrupted files in your Backup.  

Step 4:  Accessing your files
This is perhaps the most remarkable feature of ConnectMyFiles.  Your files are safe, secure and ready 
for you to access them at a moment's notice.  If you click on the third tab, labeled “Restore.” You will be 
asked if you wish to go to the ConnectMyFiles website.  This is because on the website you can easily 
select individual files that you wish to download back onto your computer.  From there, you can also 
find links to programs that open the various types of files.  

If you click, “No,” when asked if you wish to go to the website, you will be directed to the “Restore” tab. 
This part of the program allows you to return a large number of files to your computer all at once.  If, for 
example, your hard drive later becomes reformatted, corrupted, damaged or erased and you wish to 
replenish the files you have in backup; you can go to the “Restore” tab and tell it to put the files you've 
kept on our Global Network right back on your PC.  

Quick Question:  Why should I use the website to move individual files; 
can't I just use the “Restore” tab?  

The “Restore” tab can only replace files that were taken from that computer originally.  Since 
ConnectMyFiles allows you to store files from multiple computers, the “Restore” tab is only useful when it 
comes to replacing a large amount of files that were backed up from a single location.  The website 
offers far more functionality.  From the website you can select and download any file to any computer.  
Since most people don't wish to download a large number of files at any given time, the Website offers 
the perfect balance of convenience, efficiency and accessibility. 

Step 5:  Downloading or Deleting your files
Downloading files 
There are two ways to download a file that you've backed up to the Global Server.  The first, and 
easiest, way is to simply go to ConnectMyFiles.com, log in, and view the files you've backed up. 
Beside every file is a series of three action buttons.  To download a file, simply click on the green 
download button:  Your Browser will then ask you where you would like to save the file.  

The second way is to use the Restore tab.  From here you can select a series of files (more than one) 
that originated on the designated computer.  

Deleting files 
Sometimes you may wish to delete certain files from Backup, either for personal reasons or for 
reasons concerning space.  Either way, it's easy to remove files from the Global Network.  In both the 
“Restore” tab and on the website, you can opt to delete any file by pressing the delete button: 
Deleting any file not only removes it from the Network, it also prevents ConnectMyFiles from 
automatically updating its copy on scheduled backups.  If you change your mind later and wish to put 
the file back into the Network, simply find it using the “Add Backup Locations” button and restore it.  
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Step 6:  Keeping your files up to date - Backup Settings and the Automatic 
Backup
Once you've committed files to the Backup, ConnectMyFiles is designed to rescan your computer at 
regular intervals and update any files that have changed.  This way, your data on the Global Network is 
always current.  You can adjust the frequency of the Automatic Backups using the Backup Scheduler, 
outlined in the next section.  

Doing more than one scan
When you ran your fist scan, perhaps you purposely decided to leave some files or directories out of 
the initial backup.  Now that you already have a set of files in the Backup, you would like to add more 
to it and make sure that the ones you've added will also be backed up regularly.  To do this you can 
open the application and go to the “Start” tab once more.  Here you can select the file, folders or 
directory you wish to add to the scheduled Backup and hit scan.  A scan will commence, producing a 
new set of files that can be added to the Backup.  

When you click the “Backup” button, a message dialog appears.  It gives you the option of either 
adding the new of files to the scheduled Backup settings or resetting the Backup settings.  

By adding the new number of files to the current Backup, you tell ConnectMyFiles to include the new 
selection in the Backup Scheduler, thus enabling it to keep that set of files up to date as well.

Quick Question:  What if I include files that are already in the Backup; 
will ConnectMyFiles make duplicates of them?

No.  ConnectMyFiles will only keep one copy of a given file in the Backup; this is to ensure organization 
and ease of use, and to make sure that there are no unnecessary duplicates to eat up your Backup 
space.  That being said, any files that are already on the Global Network will be replaced by any 
duplicates that are added in a second scan.  While this does not damage a file in the least it does take 
time.  The more files you add to the Global Network, the more time it takes to back them up. So be sure 
that any scans you make after the first one are specific.  

Resetting a Scan
You always have the option to reset the Backup Settings completely.  When you click, “Reset Them” in 
the message dialog, a warning box will appear.  
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It reminds you that resetting the Backup Settings will overwrite all previous settings.  Consequently, 
anything in the Backup will be replaced by whatever is in the new Settings.  If you wish to simply Add 
files to the Backup without replacing files that are currently there, click, “Add Them.”  If you wish to 
erase everything in the Backup and replace it with a new set of files, click, “Reset Them.”   

Right-Clicking to manage your files
For convenience, ConnectMyFiles has a built-in file management system available at all times, even  if 
the ConnectMyFiles program is not actively running.  By right-clicking on any given file or folder, you 
are given the option to either add that file or folder the Scheduled Backup or to Back it up immediately, 
regardless of when the next Scheduled Backup takes place. 

If the file is already in the backup, you are given different options:  either you can Back the file up 
immediately, or you can actually delete it from the Scheduled Backup.  Deleting a File from the 
Scheduled Backup will not remove it from the Global Network, but it will prevent ConnectMyFiles from 
overwriting older versions with newer ones.  
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Step 7:  Keeping track of a file's status – the ConnectMyFiles Overlays
Once you start backing up files, you will notice “Overlays” on certain files. These are designation icons 
that appear attached to an individual file or folder, and they let you keep track of the Backup process.  

Files with the yellow icon are “Pending.”  They have been selected in the scan and are 
waiting in the line to be backed up.

Files with the green icon are “Backed Up.”  They have been successfully added to 
your account on the Global Network.

The blue overlay designates a folder that contains either a Backed UP or Pending file. 
This feature is simply an aid to finding files slated for backup.

You can use the overlays to keep track of a file's status.  Or you can use them to see at a glance 
whether or not a certain file has been scheduled for backup.  Once you know, you can right-click on 
that file and use the appropriate buttons to either add it to or remove it from the list.  
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Guide to Using ConnectMyFiles Part III:  The Options Menu  
Using The Options Menu 
At any point in the “Start” or “Status” tabs, you can access the Options menu by clicking the “Options” 
button.  From this menu, you can 

1. Adjust whether or not ConnectMyFiles starts when Windows Starts.
2. Set update options.
3. Determine how often you want ConnectMyFiles to run a backup.
4. Set whether the program closes when you exit it or runs in the background.
5. Adjust what kinds of logs are kept.

General Options 
Since ConnectMyFiles is designed to check for alterations in the files you've selected for backup, the 
program is set to come on whenever Windows Starts.  This way, ConnectMyFiles can activate and 
check for any changes that have been made since its last scan.  If it finds any, it will automatically back 
them up.  It is a feature meant to safeguard your data. Even if you forget to start the program, it starts 
automatically so your files are backed up and secured without your having to worry about them.  

If you don't want ConnectMyFiles to run on startup, simply un-check the box under “General Options” 
and the program will not run when Windows starts.
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Auto Update Options 
Like all respectable applications, ConnectMyFiles has the capacity to be updated whenever new 
advancements or functionality are introduced into the product.  Updates ensure that we can keep your 
copy of ConnectMyFiles running efficiently and that any new benefits are made available to you as 
soon as they're released.

You have the option to let the updates simply install automatically.  This is the default setting.  It keeps 
your version of ConnectMyFiles up to date without your having to worry about it.

Choosing the second option will notify  you when a new update is available, but you must decide 
whether or not to download or install it.

Choosing the third option shuts off the automatic updates.  You can still update your version of 
ConnectMyFiles, but you must check for updates manually by clicking the check updates link.  

The Backup Scheduler
ConnectMyFiles is designed to do as much of the work for you as possible, but only if that's what you 
want.  By default the program is designed to check for alterations in your files in specified intervals. 
After the first Backup, ConnectMyFiles will scan your computer every _____ minutes.  This is the 
default interval.  If it detects that any of the files you initially backed up have changed, it automatically 
overwrites the old copy with the new copy.  This way, the files kept on the Global Network are always 
up to date.  

With the Backup Scheduler, you have the ability to determine when and if an automatic backup occurs. 
On the left hand column you can choose which days during the week you would like an automatic 
backup to occur.  If you select no days, then there will be no automatic Backups.  

On the right, you can choose how many times a day you would like the automatic backup to occur.  If 
you select, “Run Backup All Day,” then ConnectMyFiles will scan for alterations at the default interval. 
Otherwise, you can select what time of day you wish the scan to take place.

Quick Question:  What if the automatic backup takes longer than the time-window I've specified; 
will the program stop backing up my files so it can run another scan?

No.  ConnectMyFiles is designed to maintain the integrity and security of your files.  When it begins an 
automatic backup, it continues until that backup is complete.  Once that is over, the program simply waits 
for the next scheduled scan.  If, for example, you've told ConnectMyFiles to scan and backup your files 
every fifteen minutes, but the current backup takes twenty minutes; the program will not stop in mid-
backup and start over; it will finish securing your data then wait for its next scheduled scan.    
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Exit Options
Since ConnectMyFiles is designed to backup your files automatically, the program stays open all the 
time.  That way, when a scheduled scan takes place, ConnectMyFiles will be ready.  By default, when 
you press the button that closes the program, it stays running in the background.    If you do not wish 
for ConnectMyFiles to run in the background, simply select “exit” in the “Exit Options.”  Once this 
option is selected, closing ConnectMyFiles will terminate the program.  To launch it again, simply click 
the desktop icon or run it from the Programs List in the Start Menu. 

The ConnectMyFiles Taskbar Icon
You can access the ConnectMyFiles program at any time by clicking on the       icon on the Taskbar. 
You can also hover over this icon to see a quick report of the total space you have on the Global 
Network.  Right-clicking the icon allows you to either open it if it's closed or shut it down if it's open.

Log Options
By default, ConnectMyFiles is designed to keep no specific logs of its actions whenever it backs up 
files, but it can.  With Log Options you can tell ConnectMyFiles to keep logs of everything it does, 
including which computer's files are being backed up, when, what files, and how long it took.  You can 
subsequently view the logs by clicking the “Show Logs” button. 
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Guide to Using ConnectMyFiles Part IV:  Accessing your 
files from anywhere in the world
The Web Interface
Once you have backed up your files with ConnectMyFiles, you can access them anywhere in the world 
by going to http://www.connectmyfiles.com.

Once you arrive, you will see the homepage.  From here you can download the local interface which 
will allow you to backup files on the computer you are currently using.  Notice that there are three tabs 
on this page:  The Home tab, the Access Your Files tab, and the Download tab.  The home page has 
general information about ConnectMyFiles, what it is, what it does, FAQs, and where you can get help 
if you need it.  Just click on any of the buttons on the top of the screen to go to the corresponding 
page.  

In order to access the files that you've downloaded, click on the “Access Your Files” tab.  Here you will 
be prompted to enter your user name and password.  These are the same user name and password 
you used when you set up your ConnectMyFiles account.  Password protecting your information is one 
way ConnectMyFiles keeps your data safe.   

Once you log in, you are directed to Web access point for all of your files.  No matter how many 
computers you've backed up, all of your data is available on this one interface at the click of a mouse. 
This view is the Basic View, it has a column on the left that holds the various categories that describe 
the majority of files commonly backed up.  In the center is the Documents pane, this window allows 
you to view the files and their corresponding characteristics:

➢ The File Name
➢ Three Action Buttons 
➢ The File Type
➢ The File Size
➢ The time when the file was last backed up.
➢ The original path where the file was stored on the computer.  
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Beneath the Documents pane there is a blue status pane.  In this window you can see details about 
your ConnectMyFiles account as a whole.  It tells you how much of your storage you've used and how 
much you have left.  It also lets you upgrade your ConnectMyFiles account and get Support help when 
you need it.  It's important to know when your subscription to ConnectMyFiles will expire, so the Status 
pane always tells you the exact date when that occurs.

The three Action buttons in the Documents pane
This button allows you to download a single file to any computer in the world.  All you have to do is click    it, 
and your Internet browser will prompt you as the whether you would like to open the file or save it  to disk.  It's 
that easy.

This button allows you to delete a file from the Backup.  ConnectMyFiles is the premier solution to  
storing all of your data online, but sometimes there are files that you just don't want to be backed up.  Simply 
click this button and ConnectMyFiles remove the file from the Global Server.  

The delete button does not remove any data from your hard-drive, only from the ConnectMyFiles set of global 
servers.  While this protects the original data on your computer, it also means that the file can be re-added to 
backup if you change your mind.  Unless you specify that the deleted file be removed from the scheduled 
backup, it will continue to be replenished  

This button allows you to view information about about what kind of file has been selected.  Not all files can be 
opened on all computes; often you need special programs that can accommodate them.  For example, you 
may write a certain document at work using Microsoft Word, but at home you don't have Microsoft Word, you 
have Corel Wordperfect.  The two programs are incompatible, so even if you can download a file, you can't 
necessarily open it.  ConnectMyFiles is here to help.  When you click on the blue, File Information button, we 
will provide you with a link to a program that can open the file in question.  You're not obligated to download 
anything from these vendors, but we wanted to make sure you had the option if you needed it.
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Finding my Stuff:  Navigating through ConnectMyFiles Online
ConnectMyFiles is designed to make finding files both easy and intuitive.  In the Basic view, you have 
a navigation pane to your left.  Here you can select on any type of file and that type is all that will be 
displayed in the Documents pane.  If, for example, you selected “Music” in the navigation pane, then 
the documents pane would display all of the music stored on the Global Network, no matter how many 
sources supplied it.  Once you've decided what type of file you're looking for, you can use the Search 
Field at the top of the screen to hone in on any one file.  All you have to do is type in a name or part of 
the name, click enter, and ConnectMyFiles will find what you're looking for.   

 

Specifying file types within a category
Selecting something in the navigation pane like music or pictures will respectively yield all of the audio 
or image files that you've backed up, but what if that's not good enough?  After all there are several 
types of music files, several types of image files, and several types of documents.  In the top right-hand 
corner of the screen is a drop down box that will allow you to narrow any filed by specific file extension. 
Once you've selected a general category in the Navigation pane, simply click on the drop-down box 
that says, “Only display these file types:”  The box will give you a list of file types you can choose from. 

Normal View and Tree View
On the top of the Web Interface you have the option to choose which type of view you would like to 
use.  The Normal View is the easiest way to find files by their file types.  The Tree View is simply a 
different way of looking at the same data.  In the Tree View, you can easily see how many files of each 
category are present, and if you wish to search for files by location, the Tree View is the most 
accommodating.  Here you can search as you would with Windows Explorer, expanding and closing 
various paths through a hierarchy of drives.  This way, if you feel more comfortable locating a file 
based on its path name or where it was originally stored, the tree view will let you explore with ease.  
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Guide to Using ConnectMyFiles Part V:  Restoring your files
Using the Restore tab on the website
If you click on the button that says Restore my Files you will be directed to open the ConnectMyFiles 
interface on your computer.  If ConnectMyFiles is not installed on the computer you are currently 
working at, you will be prompted to download it and install it.  This is because the restore feature is 
designed to put back only the files that originally came from a given computer.  

You may have files from several computers stored on the ConnectMyFiles Global Network.  Every file 
that is backed up is given a name that corresponds to the computer that is came from.  Thus, you must 
have the local interface installed so that it can search the files on the Global Network and restore only 
those that have a matching computer name.   If you install ConnectMyFiles on a given computer and 
there are files that match that computer, clicking restore will download only those files.  

Restoring files from the ConnectMyFiles Interface
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With the ConnectMyFiles application open, click on the Restore tab.  From here, you will be able to 
select the files you wish to restore to the computer from which they originally came.  

All that's left to do is click on the restore button and ConnectMyFiles will restore whatever you've 
selected.  It will display a progress screen as it works so that you can see exactly which file is being 
downloaded at any given interval.   

Quick Question:  Why is the Restore feature Computer Specific? 

The restore feature was designed to do just that, restore the files that where backed up.  In many 
ways, the Restore can be seen as a safety feature, a security measure that allows you to put back a 
large amount of data in the event of some error in memory such as a hard drive crash.  Hereto, the 
Restore attempts to maintain authenticity not only in the content of files being restored but also in the 
number.  The amount of data you backed up is the same amount that gets restored.

Quick Question:  What if I want to download files from another computer?

That's no problem, from the web Interface you can download any given file as many times as you 
want to any computer. 
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Quick Reference:  Frequently Asked Questions
Does ConnectMyFiles remove information from my computer?
No.  ConnectMyFiles backs up your data by making copies of your files and storing them on our Global 
Network of Servers.  

When I delete a file on the Website does it affect the original file on my 
computer?
No.  The Global Network is a separate entity from any computer.  When you back up a file to the Network, you 
are essentially making a copy of that file.  Downloading and deleting files on the Network only affects the copies; 
it does not alter or damage the original file in any way.

What if I want to disable automatic Backups completely?
To disable automatic Backups completely, simply go to the Backup Scheduler and un-check every day 
of the week.  If no days are selected, then ConnectMyFiles will never try to initiate a backup.

Why would I (and wouldn't I) restore a whole hard-drive's worth of data at 
once?
The restore function is a process whereby you take all of the files on the Global Network that came 
from a certain computer and put them back on that computer.  As such it will take a respective amount 
of time and computer resources.    

You should restore files whenever you see fit.  But because you are opting to move a (potentially) large 
amount of data at once, while also maintaining the security and integrity of your files, the Restore 
function should be recognized as a lengthy process.  

If, alternatively, you only wish to take a small number of files off of the Global Network, we recommend 
simply using the Download feature on the website.  If you don't need all of the files at one time, there's 
no real need to expend resources getting them.  ConnectMyFiles is, in many ways, a private hard-drive 
online.  As such it is a continual resource.  

I deleted a file from the website using the red delete button, but it came 
back.  Does the button not work?
When you delete a file from the Global Network, it's gone.  However that file's path is still set in the 
Backup Scheduler.  If that particular file never changes then ConnectMyFiles will never restore it to the 
Global Network.  If it does change though, the Backup Scheduler will detect the change and put the 
new version into the backup, thus making it appear as if it were never deleted in the first place.  

So how do I stop the Scheduler from restoring a file once I've deleted it?  
Simply find the file on the computer that it originally came from. Right-click it and tell it to “Remove File 
from the Scheduled Backup”:   This will prevent the file from being restored 
to the Backup, even if the file changes.  If you decide that you would like to re-add it to the Scheduled 
Backup, simply right-click it and tell it to “Backup Now”:
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